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Exam MO-210: Microsoft Excel (Microsoft 365 Apps) -
Skills Measured

Manage worksheets and workbooks (25-30%)

Import data into workbooks

= import data from text files
*  import data from oaline sources

Navigate within workbooks

= search for data within a warkbook
= navigate to named coils, ranges, or workboolk elemaents
* insert and remove hyperlinks

Format worksheets and workbooks

= modify page setup

= adjust row height and column width

®  customize headers and footers

*  customize options and views

= manage the Quick Access toolbar

= display and modify worksheets in different wiews
freese worksheet rows and columing

= change window views

= modify built-in workbook properties

= Digplay formulad

Prepara workbooks for collaboration and distribution

& L81.5 pronl Ared

= save and auport workbooks in alternative file formats
= configure print settings

®  inspect workbooks and carrect issues

= manage cemments and notes

Manage data cells and ranges (25-30%)

Manipulate data in worksheets
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Instructions

Exam Environment

Exam Interface and Controls

The exam panel provides access to the project task(s). Each project has an associated file in which you will perform the project
tasks.

A B = D E F G
Clearance mﬂ
\
3 o =
4 Appliance Biender HFXCOY 4 36.69 146.76
3 [ Appiance Coffee Maker HFX008 2 3%.3 78.6
4 Appiance Coffee Maker (french Press) HFX010 3 31.13 93.3%
/ Applonce Grill {Elecinic) HEXGO4 | 19.41 19.41
8 Grill (Cas) HFX006 4 13.28 33.12
9 Halr Dryer HFXCO7 10 17.02 170.2
1@ Microwave HFXO12 9 51.47 463.23
11 Refrigerator HFX@)4 7 29.7 2079
12 . Apptance Joaster HEXCI3 5 23.02 1151
12 [Electironics Compuler (Desktop) HEXOL8 4 39.36 157.44
|4 Elecironics Computer (Laptop] HFXC15 3 18.43 55.29
|5 .Elecironics MP3 Player HF X022 5 35.72 178.6
|4 Hecironics Video Game Console HFX020 5 B 148.5
|7 (Fumiture Beanbag Char HFXC37 2 11.19 22.38
|18 ‘Fumiiure Bed (Ful) HFX045 z 12.2% 86.03
19 Fumilure 8ed (King) HFX049 7 4572 320.04
_52_@ Vehicles + By -~
toadh 'i“’ Lrracaibdn, Invactinata
Overview:

Clearance Sale

You are the administrative assistant for a retail company that is going out of business. You've been tasked to prepare a workbook
for the clearance sale.

Task 3:

Configure the Sold worksheet so rows 1 through 3 remain visible as you scroll vertically.

ER:

L EER

See the solution in Explanation below.

Explanation:

To keep rows 1 through 3 visible while you scroll down the "Sold" worksheet, you will use theFreeze Panes feature.
Step-by-Step Solution

* Select Row 4: Click on the row number4on the far left of the screen to select the entire row.

* Note: In Excel, "Freeze Panes" freezes everythingabovethe currently selected row.

* Navigate to the View Tab: Click on theViewtab in the top Ribbon menu.

* Click Freeze Panes: In theWindowgroup, click theFreeze Panesbutton.

* Select Freeze Panes: From the drop-down menu, select the first option,Freeze Panes.

Verification

Scroll down the worksheet using your mouse or the scroll bar. You should notice that the "Clearance Sale" header and the "Item
Type/Description/etc." header row (rows 1-3) stay locked at the top of the screen while the data in row 4 and below moves.
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Instructions

Exam Environment

Exam Interface and Controls

The exam panel provides access to the project task(s). Each project has an associated file in which you will perform the project
tasks.



A B c D £ £ G

Clearance @g

AWK —

i Descripfion - |
Applionce Biender HEXCOY 4 36.69 146.76
5 Apptance Coffee Maker HFX008 2z 393 78.6
é Appiance Coffee Maker [french Press) HFXC10 3 3113 93.3%
7 Appionce Grill {Eiecinc) HEXCO4 | 19.41 19.41
8 Appfance Grill {TGas) HFX006 4 13.28 53.12
9 Appiiance Halr Dryer HFX027 10 17.02 170.2
¢ Ap Microwave HEXO12 9 51.47 463.23
|1 {Appliance Refrigerator HFX@14 7 297 207.9]
12 . Apptance Toaster HEXCI3 5 23.02 11581
2 Hectronics Compuler (Desklop) HFROLES 4 39.3¢6 157.44
4 Hectronics Computer (Laptop) HFXC15 3 18.43 55.29
|5 ‘ElecTronics MP3 Player HF X022 5 35.72 178.6
| & Hectronics VYideo Game Console HFX020 5 29.7 148.5
17 Fumiture Beanbag Char HFX037 2 1119 22.38
18 Fumiture Bed (Ful) HFX045 7z 12.29 86.03i
19 Fumilure Bed (King) HFX049 7 45.77 320.04
LM Vehicles + HERES S
taarh Q arracsibans Invactinata
Overview:

Clearance Sale

You are the administrative assistant for a retail company that is going out of business. You've been tasked to prepare a workbook
for the clearance sale.

TaskS5:

On the Vehicles worksheet, in the Code colunmn cell B4, create a formula that returns the two leftmost letters of the vehicle style
displayed in cell D4.

ER:

fif R «

See the solution in Explanation below.

Explanation:

To extract specific characters from the start of a text string in Excel, you use theLEF Tfunction.
Step-by-Step Solution

* Navigate to the Worksheet: Click on theVehiclesworksheet tab at the bottom of your Excel window.
* Select Cell B4: Click on cellB4(under the "Code" colummn).

* Enter the Formula: Type the following formula exactly as shown: =LEFT(D4, 2)

* Press Enter: Once you press Enter, Excel will look at the ""Vehicle Style" in cellD4and return only the firsttwoletters.
Explanation of the Formula

* LEFT: This is the function used to start counting characters from the beginning (left side) ofa cell.

* D4: This tells Excel which cell contains the text you want to extract from (the Vehicle Style).

* 2: This specifies the number of characters you want to retrieve.
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Instructions

Exam Environment

Exam Interface and Controls

The exam panel provides access to the project task(s). Each project has an associated file in which you will perform the project
tasks.
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Jx  Production Costs (per pound)
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4 Chocolate Fudge 2,34 5.68 662 1416.63 3760.26 234341
5 Nutty Nuts 736 5.20 552 =1 3078.40 1681.38
6 |Vanilla Bean 2.59 5.83 :G:, 1539.12 855.36
7 Pancake Syrup _ 1.78 4.99 1337.36 Ba7.44
8 Caramel 36— ag3 - 457- 60 1781.80 B24,2¢
g {innamon Danut 1.54 4.32 400.56 1146.48 733.97
o Mocha Coffee 7.56 5.% s, 522.24 1151.36 ~ 66g.i3
t2 Black Bean 1.46 & 33 340.38 952.97 6132.79
1z Pistachio 1.28 260 332.80 533.40 fioa.6c
13 Blueberry Chacolate 2.32 (8] 143 331.76 929.50 597.74
14 Red Heot Chili ' 1.15 50 260 _5,25.00. 91::.00 '535.61:
5 -_C,trawhenry 2.28 5.34 i78 405.84, 950.52 564.68
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19 Cheesecake * 3.25 G.37 154 500.50 sfio.qf ;8041
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13 Keylime 1.79 4468 154 275.606 6flg.92 41428



Flavor Expenses, Income and Profit

nmnumm i

Jelly Beans

A shop you manage sells gourmet jelly beans. You are tracking the amount of jelly beans sold each quarter and summarizing the
information in aworkbook.

Task 3:

On the Chart worksheet, include the Total Profit data on the Flavor Expenses, Income and Profit chart.

ER:

f# RS -

See the solution in Explanation below.

Explanation:

To include theTotal Profitdata in your existing chart on theChartworksheet, follow these steps:
Step 1: Navigate to the Chart

* Click on theChartworksheet tab at the bottom of the Excel window.

* Click once on theFlavor Expenses, Income and Profitchart to select it. When selected, you will see the Chart
DesignandFormattabs appear on the Ribbon.

Step 2: Open the Select Data Source Window

* Go to theChart Designtab.

* In theDatagroup, click on theSelect Databutton. This will open theSelect Data Sourcedialog box.
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Step 3: Add the Total Profit Series

* In theLegend Entries (Series)section on the left side of the dialog box, click theAddbutton.

* AnEdit Serieswindow will appear:

* Series name:Click on theProfitsworksheet tab and select cellG3(which contains the header

"Total Profit").

* Series values:Clear any existing text in the box, then highlight the range(G4:G23on theProfits worksheet (containing the actual profit
numbers).

* ClickOKon the Edit Series window.

* ClickOKagain on the Select Data Source dialog box to apply the changes.

Select aidg!bjm:e
o IVicrosoft

Chart data range: | = Profits!SAS3:808206, Profits! SES3:5C526

HQSgllrh RC'A,’CGH.III’III
Legend Entries (Series)

[iHadd E7 £ X Bemove
B Epense !I i chocotate Fudge

B  ncome Nutty Muts
B  Teuwleroft ‘\"’ Vanila Bean

-
B  rPancake Syrup
a

Caramel

Hidden and Empty Celis Cancel

Final Result
The chart will now display a third set of bars (likely orange, as seen in your preview) representing the Total Profitfor each flavor
alongside the existing Expense and Income data.
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Instructions

Exam Environment

Exam Interface and Controls

The exam panel provides access to the project task(s). Each project has an associated file in which you will perform the project
tasks.



= Moiorhome R efilals

2 v _q?, ¢ jund - -
3 2 Sierra 'at 3600 2880 2700
4 2 Redweood 2780 3720 2980 2790
5 4 Sequila f TN 3020 4025 3220 3020
3 4 Fern 3880 5175 4140 3880
7 [ Vista 4940 6010 5270 4940
2 [ Seascape 4940 6590 5270 4940
9 8 Qutlock 5180 6000 5530 5180
o 8 Peaks 8440 10000 9000 8440
Rentals +
Overview:
Motorhome Rentals

Your company rents motorhomes. The motorhomes rent year-around at different prices. You are preparing pricing worksheets to be
shared with others.

TaskS:

On the Rentals worksheet, configure the heading row in the table so that entries wider than the colunm wrap to multiple lines.

ER:

S RE R «

See the solution in Explanation below.

Explanation:

To ensure that the text in your heading row (the table headers) is fully visible without changing the column width, you will use
theWrap Textfeature.

Step-by-Step Solution

* Select the Header Row:In your "Rentals" worksheet, click and drag to select the cell rangeA2:F2(the orange heading row
containing "Capacity," '"Fleet Name," etc.).

* Navigate to the Home Tab:Ensure you are on theHometab of the Ribbon.

* Apply Wrap Text:

* Look for theAlignmentgroup.

* Click theWrap Textbutton (usually represented by an "ab" icon with a curved arrow).

* Verify the Result:The text in your headers will now automatically wrap to muitiple lines if it exceeds the current width of the
column.
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Instructions

Exam Environment

Exam Interface and Controls

The exam panel provides access to the project task(s). Each project has an associated file in which you will perform the project
tasks.



Top 20 Video Games of All Time

These games were selected because they are both fun to play and have had a significant
impact on the video game ifidustry.

Rank Name Year

#1 _ Minecraft

-

#4__[The Witcher 3: Wild Hunt
#5  Super Smash Brothers Ultimate
#6  The Legend of Zelda: Ocarina of Time

>

2011 !

1984
1996
2015
018

. Recent Releases

2 These games were selected because they are both fun to play and have had a significant impact on the video game industry.

3

4 A Little to the Left (PC)

& A Plague Tale: Requiem (PlayStation S, Xbox Series X/S, Switch, PC)
& Advance Wars 1+2: Re-Boot Camp (Switch)

& Aftermath (PlayStation 5, Xbox Series X/S, PlayStation 4, PC)
cArc Raidars (PlayStatipn Syibox Serigs &/S, PC)

i Ast

3s: Curse ofthe Stafs{PlayStation 5, PlayStation 4, PC)

11 Atomic Heart (PlayStation 5, Xbox Series X/S, PlayStation 4, Xbox One, PC)
iz Mwvatar: Frontiers of Pandora (PlayStation 5, Xbox Series X/5, Stadia, PC)

13 Away: The Survival Series (Xbox One)

14 Balsa Model Flight Simulator (PC)

16 BattleCakes (Xbox Ona, PC)

17 Bayonetta 3 (Switch)

18 Bear and Breakfast [Switch, PC)

15 Blazing Strike (PlayStation 5, PlayStation 4, Switch, PC)
v Bload Bowl 3 [PlavStation 5. Xhax Series XJ/5. PlavStation 4. Xhex One. Switeh. PCY
Project 1

Overview:
Video Ganes

You are tracking video game popularity by compiling a workbook to document your findings.

Task 2:
On the Top 20 Videos worksheet, change the width of column C to 2.

ER:
fRRE RS «

Here are the complete solutions below.
Explanation:

Step-by-Step Instructions

* Navigate to the Correct Worksheet:
* Click on the tab labeled Top 20 Videos at the bottom of the Excel window to ensure you are on the correct sheet.
* Select Colunmn C:
* Click on the letter C in the colunn header to select the entire colunn.
* Open Column Width Settings:

* Method A (Ribbon): Go to the Home tab. In the Cells group (towards the right), click Format.

Select Column Width... from the dropdown menu.
* Method B (Right-click): Right-click directly on the colunn header "C". A context menu will appear. Click Colunmn Width...
* Enter the Width:

* A small dialog box labeled "Colunmn Width" will appear.
* Type 2 in the box.

* Click OK.

Visual Verification

Before: Column C (containing the "Year" data) is likely wider, fitting the four-digit years comfortably.

C

D

After: Colunmn C will become very narrow. The "Year" header and the dates (like 2011, 1984) might display as hashes (###)
because the column is now too narrow to display the numbers, or the text will simply be cut off. This is expected behavior for the




examtask; do not widen it back out unless instructed to do so.
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